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บทสรุป 

จากการไปฝึกงานแผนกบุคคลของบริษทั ไทยแอร์โรว ์โปรดกั โรงงานบางพลี   

พบว่ามีขั้นตอนท่ีสามารถปรับปรุงการทาํงานได ้ ซ่ึงพบความล่าชา้ในเร่ืองของเวลาท่ีใชใ้นการ

ปฏิบติังานมากเกินไป จึงไดเ้ขา้ไปศึกษาขอ้มูลเพื่อแกไ้ขปัญหาดงักล่าวโดยใชว้ิธีการวิเคราะห์โดย

ใช้เคร่ืองมือ การวางผงัโรงงาน เพื่อวิเคราะห์การจดัผงัการทาํงานใหม่  รวมถึง การใช้เคร่ืองมือ 

Flow Process Chart เพ่ือนาํมาประกอบการพิจารณาว่าควรปรับปรุงกระบวนการใดบา้ง อีกทั้งยงั

สร้างคู่มือในการทาํบตัรพนักงาน ให้สามารถทาํงานออกมาเป็นมาตรฐานเดียวกนัอีกดว้ย  และ

สามารถลดระยะทางในการเคล่ือนท่ีได ้จากเดิมประมาน 206 เมตร เหลือเพียง 54 เมตร รวมทั้ง ไป 

– กลบั คิดเป็น 70% และสามารถลดเวลาในการทาํบตัรพนักงานลงได ้จากเดิมใชเ้วลา 712 วินาที 

หรือ 12 นาที เหลือเพียง 453 วินาที หรือ 8 นาที โดยคิดเป็น 36 %  ซ่ึงผลท่ีไดส้ามารถสรุปไดว้่า 

บรรลุวตัถุประสงคท่ี์ตั้งไว ้
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Project name   Thai arrow smart card process improvement  

Cast Study : Thai arrow product Co., Ltd. 

Writer    Mr. Keerati  Pradist 

Faculty    Faculty of Business Administration ,Industrial Management 

Faculty Advisor  Mr. Pongsak Saithanya   

Job Supervisor   Mr. Sompong  Keawpijit    

Company  name  Thai arrow product Co., Ltd. 

Business Type / Product  Car wiring harness , Combination meter 
Summary 

From an internship education department Personnel at Thai arrow product Co., Ltd. We 

found some process that can be improvement. A problem of that process effect to delay time in 

smart card operation. So learn to method and information for resolve a problem by using Plant 

Layout for analyze a better layout and using Flow Process Chart in considering what process that 

should be develop including creation work instruction about smart card creation for make a 

standard time and distance , finally  can be reduce a distance in moving from 206 meter to 45 

meter include go and back is lower 70% and can make time in creation smart card lower from 712 

second or 12 minute to 453 second or 8 minute is 36% . The result is more than the target set at 

the beginning of the project much. 
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กติตกิรรมประกาศ 
 

 การฝึกงานในคร้ังน้ีสาํเร็จลุล่วงดว้ยความอนุเคราะห์จากบริษทั ไทยแอร์โรว ์โปรดกั จาํกดั
โรงงานบางพลี และสถาบนัเทคโนโลยีไทย-ญ่ีปุ่น ไดรั้บความกรุณาจากนาย สมพงษ ์แกว้พิจิตรท่ี
ปรึกษาโครงการฝึกงาน ผูค้วบคุมการสหกิจตลอดทั้ง 2 เดือนและอาจารยพ์งศศ์กัด์ิ สายธญัญา ท่ีให้
คาํปรึกษาการฝึกงาน และฝ่ายสหกิจศึกษาท่ีไดใ้ห้คาํปรึกษา แนะนาํตลอดจนแกไ้ขขอ้บกพร่อง
ต่างๆแก่นักศึกษาท่ีมาฝึกงานท่ีบริษัท ไทยแอร์โรว์ โปรดัก จํากัด โรงงานบางพลี ขอกราบ
ขอบพระคุณเป็นอยา่งสูง 
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บทที ่1 

บทนํา 

1.1 ช่ือและทีต่ั้งของสถานประกอบการ 
 

ภาพที ่1.1  บริษทัไทยแอโรว ์จาํกดั โรงงานบางพลี 

สถานทีต่ั้งบริษัท ไทยแอโรว์ จํากดั โรงงานบางพล ี

สํานักงานใหญ่  

เลขท่ี142 ถนน สุขมุวิท   ก่ิง อ.คลองเตย   กรุงเทพ 10110 อาคาร Two Pacific Place Building ชั้น25  

 

 

 

 

 

 
ภาพที ่1.2 สาํนกังานใหญ่ 
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โรงงานบางคล้า 

เลขท่ี  79 หมู่ 4 ต.เสมด็ใต ้ อ.บางคลา้ จ.ฉะเชิงเทรา 24110  

 

 

โรงงานพษิณุโลก 

เลขท่ี 230 หมู่7  ต.หวัรอ  อ.เมือง  จ.พิษณุโลก  65000   

 

 

 

 

ภาพที ่1.4  โรงงานพิษณุโลก 

ภาพที ่1.3  โรงงานบางคลา้ 
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1.1.2 ประวตัิความเป็นมาของบริษัท  ไทยแอร์โรว์ จํากดั  

 บริษทั ไทยแอโรว ์จาํกดั  มีสาขาทั้งหมดซ่ึงเป็นโรงผลิตในประเทศไทย 3 โรงงาน ซ่ึง

สาํนกังานใหญ่ตั้งอยูท่ี่ เขตกรุงเทพมหานคร แขวงคลองเตย  ซ่ึง บริษทั ไทยแอโรว ์จาํกดั (โรงงาน

บางพลี) จดัตั้งมาทั้งหมด  30   ปี   ปัจจุบนัมีพนกังานทั้งหมด จาํนวน 3188  คน  โดยสามารถแบ่ง

ประเภทของพนกังานได ้ดงัน้ี 

- พนกังานสญัญาจา้งประจาํ 

- พนกังานจาก Out Source บริษทั S.K.จาํกดั 

- พนกังานจาก Out Source บริษทั B.N.Gจาํกดั 

มีสวสัดิการใหก้บัพนกังานทุกคน เช่น ขา้วเปล่าฟรี , โบนสั , เบ้ียขยนั, เงินช่วยเหลือค่าครอง

ชีพ,เงินช่วยเหลือค่าฌาปนกิจ ,  เงินช่วยเหลือค่ารักษาพยาบาล , เบ้ียตารางวนัหยดุ , สวสัดิการ

เก่ียวกบัเร่ืองของการตั้ง ครรภใ์นพนกังานหญิง  ,  ชุดทาํงาน   และ ประกนัอุบติัเหตุ 24 ชัว่โมง เป็น

ตน้     

ภาพที ่1.5  ภาพบริษทัในเครือไทย ยาซากิ 
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รถรับ - ส่ง  มีทั้งหมด 2 ประเภท ไดแ้ก่ รถบสั รับ - ส่ง พนกังานทัว่ไป และ รถตูป้รับ

อากาศ    ซ่ึงมีเวลาในการ รับ - ส่ง ต่างกนั  

ปัจจุบนั บริษทั ไทยแอโรว ์จาํกดั (โรงงานบาลพลี)  ไดรั้บใบประกาศรับรองระบบบริหาร

คุณภาพ  ISO ซ่ึงเป็นมาตรฐานสากลส่งผลใหบ้ริษทักา้วไปสู่ความเป็นผูน้าํ ทางดา้นอุตสาหกรรม

สายไฟรถยนต ์และ มาตรวดั รถยนต ์ 

1.1.3 ข้อมูลของบริษัท  

     วนัก่อตั้งบริษทั  :ค.ศ.1972 

จาํนวนพนกังาน                                  :3188คน  

ผลิตภณัฑ ์                                           :สายไฟรถยนต ์และ มาตรวดัรถยนต ์

ลูกคา้                                                   :ส่งออก และ จาํหน่ายภาพในประเทศ 

เร่ิมการผลิต                                         :ค.ศ. 1994  

มาตรฐานท่ีไดรั้บการรับรอง               : ISO - 14001 , ISO - 16949 , ISO - 9001  

1.1.4 จํานวนพนักงาน 

 

 

ภาพที ่1.6  อตัราแรงงาน 
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1.2 ลกัษณะธุรกจิ  

               มีการผลิตแบ่งออกเป็น 2 ส่วน ส่วนแรกคือ การผลิตสายไฟฟ้าหุม้ฉนวน เพื่อติดตั้ง

ในโครงสร้างรถยนต ์  และนาํส่งใหก้บับริษทัรถยนต ์เช่น Toyota , Honda , Mitsubishi  เป็น

ตน้ส่วนท่ีสอง คือ การผลิตมาตรวดัรถยนต ์  อาทิเช่น หนา้ปัดเขม็บอกไมล ์ เป็นตน้  จากนั้นก็

ทาํการนาํส่งใหก้บัลูกคา้ในประเทศและต่างประเทศ เช่นบริษทั   Toyota , Honda , Mitsubishi  

เป็นตน้ 

1.2.1. ตัวอย่างผลติภณัฑ์  

 

 

 

 

 

 

 

 

 

 

 

ภาพที ่1.8  ตวัอยา่งผลิตภณัฑส์ายไฟรถยนต ์

 

 

 

ภาพที ่1.7  ตวัอยา่งผลิตภณัฑม์าตรวดัรถยนต ์
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1.2.2.สัดส่วนลูกค้า 

 

 

1.3.1 การจัดรูปแบบองค์กรของบริษัท ไทยโรว์ จํากดั (โรงงานบางพล)ี  สามารถแบ่งได้ 2 ลกัษณะ

การจดัรูปแบบของบริษทั ไทยโรว ์จาํกดั (โรงงานบางพลี)จาํกดั จะแบ่งได ้2 ลกัษณะดงัน้ี 

1.องคก์ารตามหนา้ท่ี (Functional structure) คือการเอาผูท่ี้มีความสามารถหรือความชาํนาญรวมไป

ถึงผูท่ี้มีความรู้ในดา้นเดียวกนัไวใ้นหน่วยงานเดียวกนัโดยแบ่งตามหนา้ท่ีทางธุรกิจเป็นสาํคญั 

เพื่อใหบ้รรลุวตัถุประสงคข์ององคก์ารท่ีตั้งไว ้

2.การออกแบบองคก์ารแบบเมทริกซ์ (Matrix) คือการทาํหนา้ท่ีซํ้ าซอ้นกบัหนา้ท่ีและหน่วยงานต่าง 

ๆ ขององคก์าร ผูป้ฏิบติังานตอ้งทาํงาน 2 หน้าท่ี คือหน้าท่ีหลกัท่ีทาํอยู่แลว้และตอ้งไปทาํงานใน

โครงการโดยการ “ยมืตวั” เม่ืองานของโครงการเสร็จแลว้กต็อ้งกลบัไปทาํหนา้ท่ีเดิม  

 

 

1.3 รปแบบการจัดองค์กรและการบริหารองค์กร 

ภาพที ่1.9  แสดงถึงอตัราส่วนของลูกคา้ 
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ภาพที ่1.10 LOGO 

1.3.2 โลโก้ของบริษัท 

 

 

 

 

1.3.3 ปรัชญาองค์กร 

            “บริษัทจะก้าวเดินไปพร้อมกบัโลก    และเราจะเป็นส่ิงทีสั่งคมต้องการ” 

世界
せ か い

とともにある企業
きぎょう

 、社会
しゃかい

から必要
ひつよう

とされる企業
きぎょう
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1.3.4 นโยบายการบริหารงานของบริษัทไทยแอโรว์ จํากดั (โรงงานบางพล)ี 

ลูกค้าพงึพอใจ 

ส่งมอบผลิตภณัฑต์ลอดจนการบริการตามท่ีลูกคา้ตอ้งการโดยการควบคุม และ ส่งเสริม

การปรับปรุงคุณภาพอยา่งต่อเน่ือง 

คุณภาพเป็นอนัดับแรก 

พนกังานและผูบ้ริหารทุกระดบั ตอ้งตระหนกัถึงความสาํคญัของคุณภาพ และ มีส่วนร่วม

ในกิจกรรมดา้นคุณภาพ 

รับผดิชอบต่อสังคม 

ร่วมกนัแกไ้ขปรับปรุง และ คงรักษาสภาพแวดลอ้มการทาํงานใหเ้หมาะสม  โดยการทาํ

กิจกรรมอบรมในบริษทัและมอบผลิตภณัฑท่ี์ปลอดภยัใหก้บัสงัคม 

 

จากภาพท่ี 1.5 แสดงใหเ้ห็นถึงสายงานและอาํนาจในการมอบหมายงาน และกรอบรูปสีแดงยงับ่ง

บอกถึงแผนกหรือผูบ้งัคบับญัชาของการไปทาํการฝึกงาน  

ภาพที ่1.11  Organize Chart 
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1.4 ตําแหน่งและหน้าทีง่านทีนั่กศึกษาได้รับมอบหมาย 

จากการฝึกงานท่ีผา่นมา  ไดรั้บตาํแหน่งและหนา้ท่ีในการเป็นพนกังานของแผนกบุคคล ฝ่าย

สารสนเทศและประชาสมัพนัธ์ โดยมีหนา้ท่ีหลกัๆดงัต่อไปน้ี 

1.4.1 ทาํบตัรพนกังานใหม่ 

1.4.2 จดัทาํบตัรพนกังานแบบชัว่คราว 

1.4.3 จดัทาํแกไ้ขเปล่ียนแปลง Data และขอ้มูลหนา้บตัรพนกังาน 

1.4.4 ทาํการ อพัเดทขอ้มูลข่าวประชาสมัพนัธ์ใน Intranetของบริษทั 

1.4.5 เป็นเจา้หนา้ท่ีตรวจหาสารเสพติดโครงการโรงงานสีขาว 

 

1.5 พนักงานทีป่รึกษาและ ตําแหน่งงานของพนักงานทีป่รึกษา 

     นาย สมพงษ ์  แกว้พิจิตร     ตาํแหน่ง : พนกังานฝ่ายบุคคล 

1.6 ระยะเวลาทีป่ฏิบัต ิ

      17 มีนาคม - 17  พฤษภาคม  2557  เป็นระยะเวลาทั้งส้ิน 2 เดือน 

1.7 วตัถุประสงค์หรือจุดมุ่งหมายของงการปฏิบัตงิาน 

1.7.1 ลดเวลาในการทาํบตัรพนกังาน1ใหไ้ดอ้ยา่งนอ้ย 30% 

1.7.2ลดระยะทางในการทาํบตัรพนกังานใหไ้ดอ้ยา่งนอ้ย 60% 

1.7.3 สร้างคู่มือการทาํงานเร่ือง การทาํบตัรพนกังาน 
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1.8 ผลทีค่าดว่าจะได้รับจากการปฏิบตัิงานหรือโครงงานทีไ่ด้รับมอบหมาย 

1.8.1สามารถลดเวลาในการทาํบตัรพนกังานได ้

1.8.2สามารถลดระยะทางในการทาํบตัรพนกังานได ้

1.8.3 มีคู่มือในการทาํบตัรพนกังาน 

 

 

 

 

 



 
 

บทที ่2 
เนือ้หา แนวคดิ ทฤษฎทีีเ่กีย่วข้องในการปฏิบัตงิาน 

2.1 Flow Process Chartแผนภูมิกระบวนการ 

เป็นเคร่ืองมือช้ินสาํคญัท่ีใชใ้นการบนัทึกขอ้มูลไดอ้ยา่งละเอียด และ กระชบั ประกอบไปดว้ย
สญัลกัษณ์ คาํบรรยาย และ ลายเสน้เพื่อบ่งบอกถึงรายละเอียดของขั้นตอนกระบวนการผลิต เพื่อ
ช่วยใหน้กัวเิคราะห์สามารถมองเห็นภาพของกระบวนการผลิตไดอ้ยา่งชดัเจนตั้งแต่ตน้จนจบ และ
นาํไปสู่การพฒันาและปรับปรุงกระบวนการทาํงานใหดี้ข้ึน   ซ่ึงแผนภูมิกระบวนการไหล(Flow 
process chart)จะเนน้ในการใชว้ิเคราะห์ขั้นตอนการไหล (Flow)ของวตัถุดิบ ช้ินส่วน พนกังาน  
และ อุปกรณ์ ท่ีเคล่ือนไปในกระบวนการพร้อมๆกบักิจกรรมต่างๆ โดยใชส้ญัลกัษณ์มาตรฐาน 5 
ตวั ซ่ึงกาํหนดโดย ASMEในสหรัฐอเมริกา ดงัน้ี  

 
 
 

 

 

 

 

 

ภาพที ่2.1  ภาพบอกสญัลกัษณ์ต่างๆท่ีใชใ้นแผนภูมิกระบวนการ 
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2.1.1 แนวทางการวเิคราะห์แผนภูมิกระบวนการไหล 

2.1.1.1 กาํหนดวตัถุประสงคใ์นการวเิคราะห์ใหช้ดัเจนเช่น เพื่อลดปริมาณการเคล่ือนยา้ย หรือ เพิม่
ประสิทธิภาพการผลิต เป็นตน้  

2.1.1.2 ช้ีบ่งกระบวนการท่ีตอ้งการจะศึกษา พร้อมทั้งรายละเอียดของกระบวนการ  

2.1.1.3 กาํหนดวา่เป็นการวเิคราะห์การไหลของเร่ืองใดเร่ืองหน่ึง ดงัน้ี  

- ผลิตภณัฑ ์:การทาํงานบนตวัผลิตภณัฑต์ั้งแต่ ช้ินส่วน วตัถุดิบ เขา้สู่สายการผลิตจนประกอบเสร็จ
เป็นผลิตภณัฑ ์

- พนกังาน : การปฏิบติังานของพนกังานคนหน่ึงในการทาํงาน เคล่ือนยา้ยส่ิงของ และ การเดิน 

- เคร่ืองมือหรืออุปกรณ์ : การโยกยา้ยของเคร่ืองมือหรือการใชง้านของอุปกรณ์ 

2.1.1.4 เร่ิมวิเคราะห์จากจุดเร่ิมตน้ของการไหล บนัทึกงานตามท่ีเกิดข้ึนจริงโดยใชส้ญัลกัษณ์ กาํกบั
กิจกรรมท่ีเกิดข้ึนอยา่งละเอียดทุกขั้นตอน พร้อมทั้งคาํบรรยายสั้นๆ ถึงลกัษณะงานท่ีเกิดข้ึน 

2.1.1.5 เกบ็ขอ้มูลรายละเอียดท่ีเก่ียวขอ้ง 

2.1.1.6 โยงเสน้ระหวา่งสญัลกัษณ์จากบนลงล่าง 

2.1.1.7 สรุปขั้นตอนการปฏิบติังานลงในตารางสรุปผล 

     การวิเคราะห์แผนภูมิกระบวนการไหลควรมีการวิเคราะห์เสน้ทางการเคล่ือนยา้ยลงในแผนภาพ
การไหล (Flow diagram) เพื่อดูควบคู่กนัไปดว้ยเพื่อใหเ้ห็นภาพท่ีสมบูรณ์ข้ึน  

    แผนภาพการไหลคือ แผนภาพท่ีมีการจาํลองสถานท่ีหรือผงัของบริเวณท่ีทาํงานพร้อมตาํแหน่ง
ของแผนกงานหรือเคร่ืองจกัรสาํคญัๆ ลงในภาพ และแสดงเสน้ทางการเคล่ือนยา้ยพร้อมสญัลกัษณ์
ลงในผงั 
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ตวัอยา่ง Product Flow Process Chart : การผลิตโครงลิฟตย์กรถ 

 

 

 

 

 

 

 

 

ภาพที ่2.2  ภาพตวัอยา่งผงัแสดงการเคล่ือนท่ี 

 

 

 

 

 

 

 

ภาพที ่2.3  ภาพแสดงการไหลของงาน 
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2.2 หลกัการ ECRS 

 หมายถึง เป็นหลกัการท่ีประกอบดว้ย การกาํจดั (Eliminate) การรวมกนั (Combine) การจดัใหม่ 
(Rearrange) และ การทาํใหง่้าย (Simplify) ซ่ึงเป็นหลกัการง่ายๆ อธิบายไดง่้ายๆ ดงัน้ี 
E = Eliminate หมายถึง การตดัขั้นตอนการทาํงานท่ีไม่จาํเป็นในกระบวนการออกไป กล่าวคือ เดิม
บรรจุภณัฑเ์พือ่การขนส่ง (หีบห่อภายนอก) ใชก้ระดาษกล่องลูกฟกู 5 ชั้น เกรดกระดาษค่อนขา้งดี 
พิมพล์ายยีห่อ้ 2 สี นํ้าหนกัสุทธิไม่เกิน 2 กิโลกรัม ขา้งในบรรจุสินคา้ประเภทขนมขบเค้ียว คือ มี
กล่องบรรจุขนาด 1 โหล พลาสติกซีลเรียบร้อย ฉลากสีสวยงาม สาํหรับการขายส่ง และภายใน
กล่อง จะเป็นขนมซ่ึงบรรจุในซองพลาสติกอดัก๊าซไนโตรเจน พิมพล์ายสวยงาม 
C = Combine หมายถึง การรวมขั้นตอนการทาํงานเขา้ดว้ยกนั เพื่อประหยดัเวลาหรือแรงงานใน
การทาํงาน ส่ิงท่ีเห็นไดช้ดัวา่เเร่ืองของการขนส่งแบบ milk run (มิลค์รัน) แต่ผมขอยกตวัอยา่งท่ีเพิง่
พบเห็นในโรงงาน คือ เดิมพนกังานตรวจสอบคุณภาพตอ้งตรวจสอบสินคา้สาํเร็จรูป และวตัถุดิบ 
ในอดีตท่ีผา่นมามกัจะทาํงานไม่ทนั โดยเฉพาะในช่วงเวลาท่ีวตัถุดิบเขา้ และตอ้งส่งมอบสินคา้
ใหก้บัลูกคา้ในเวลาไล่เร่ียกนั ท่ีสาํคญัหากไม่มีผลจาการตรวจสอบกไ็ม่สามารถส่งมอบสินคา้ให้
ลูกคา้ หรือนาํวตัถุดิบไปผลิตได ้การดาํเนินการง่ายๆ ท่ีไปคุยกบัทางโรงงานกคื็อ การรวมเขา้
ดว้ยกนั หลกัการกคื็อตั้งคาํถามวา่พนกังานตรวจสอบคุณภาพจาํเป็นตอ้งรับสินคา้ดว้ยหรือไม่ 
คาํตอบกคื็อไม่ตอ้งเพียงแต่มาเกบ็ตวัอยา่งไปตรวจสอบ กเ็ลยเสนอวิธีการวา่ใหพ้นกังาตรวจสอบ
คุณภาพสอนวธีิการเกบ็ตวัอยา่งกบัพนกังานรับสินคา้ แลว้ใหพ้นกังานรับสินคา้เกบ็ตวัอยา่งให ้
ส่วนดา้นสินคา้สาํเร็จรูปกเ็ช่นกนั นาํแนวคิดของ Quality Built-In เขา้มาใช ้คือใหพ้นกังานผลิตเป็น
ผูต้รวจสอบสินคา้ท่ีตนเองผลิต ส่วนพนกังานตรวจสอบคุณภาพใหมี้หนา้ท่ีเพียงการสุ่มตรวจ
เท่านั้น 
R = Rearrange หมายถึง การจดัลาํดบังานใหม่ใหเ้หมาะสม กคื็อขั้นตอนของการตรวจสอบกล่อง
บรรจุภณัฑ ์เดิมจะตอ้งไดก้ล่องสาํเร็จรูปแลว้จึงตรวจสอบ ซ่ึงสาระสาํคญัของการตรวจอยูท่ี่คุณภาพ
การพิมพ ์เช่น เฉดสี ความคมชดั ซ่ึงหากผลการตรวจไม่ผา่นกต็อ้งปฏิเสธสินคา้นั้น หากเรายา้ย
ขั้นตอนการตรวจสอบคุณภาพการพิมพไ์ปก่อนการข้ึนรูป กจ็ะทาํใหส้ามารถปฏิเสธสินคา้ก่อน ไม่
ตอ้งเสียเวลา และตน้ทุนในการข้ึนรูปกล่องอีก 
S = Simplify หมายถึง ปรับปรุงวิธีการทาํงาน หรือสร้างอุปกรณ์ช่วยใหท้าํงานไดง่้ายข้ึน ตวัอยา่ง
ของโรงงานหน่ึง ท่ีมีปัญหาเก่ียวกบัลายมือของพนกังานท่ีเขียนมาบนเอกสารท่ีไดรั้บ ทาํให้
หน่วยงานท่ีไดเ้อกสารนั้นตอ้งทาํการเดา ส่งผลใหเ้กิดการผลิตสินคา้ผดิรุ่น ผดิขนาด ผดิฉลาก หาก
โรงงานทาํการเปล่ียนแบบฟอร์มของเอกสารใหม่ลดการเขียนลงเป็นมีช่องใหเ้ลือกรุ่น ขนาด ฉลาก 
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แทน กจ็ะทาํงานไดง่้ายข้ึน หรือมีบริษทัหน่ึงแต่ละแผนกใชช่ื้อเรียกสินคา้แตกต่างกนั ทาํใหต้อ้งมา
เดาวา่ฝ่ายตลาดเรียกแบบน้ี แลว้จะเป็นช่ืออะไรของฝ่ายวางแผนการผลิต ซ่ึงวิธีท่ีทาํใหง่้ายข้ึนกคื็อ 
ใชร้หสัสินคา้ท่ีเป็นตวัเลขแทนช่ือเรียกสินคา้ จะป้องกนัความสบัสนของพนกังานไดง่้ายกวา่ 
ตัวอย่าง : เทคนิคการคิดวิธีการปรับปรุงแบบ 
2.2.1  ขจัดส่ิงทีไ่ม่จําเป็น (Eliminate) 
ใหน้กัเรียนขจดัส่ิงท่ีไม่จาํเป็นหรืองานท่ีไม่จาํเป็นออกไป เช่น ในขั้นตอนการทาํก๋วยเต๋ียว แม่คา้
ตอ้งพิจารณาวา่มีส่ิงใดบา้งท่ีไม่จาํเป็นในการทาํก๋วยเต๋ียวมาวางทาํใหเ้กะกะ หรือเป็นอุปสรรคใน
การทาํงาน หรือแมก้ระทัง่ขจดัวิธีการทาํงานท่ีไม่จาํเป็น เช่น การกม้เพือ่หยบิลูกช้ิน และเน้ือสตัวม์า
ลวก แม่คา้ควรขจดัการกม้ลงออกไป นอกจากจะทาํใหป้วดหลงัแลว้ยงัเป็นการเสียเวลาอีก โดย
แม่คา้อาจคิดวา่ควรมีโตะ๊มารองกน้ถงันํ้าแขง็ใหสู้งข้ึนเพือ่จะไดไ้ม่ตอ้งกม้อีก 
2.2.2 หาวธีิการจับมารวมกนั (Combine) 
จากตวัอยา่ง แม่คา้ตอ้งหยบิเสน้ก๋วยเต๋ียวและถัว่งอกคนละท่ีกนั ทาํใหเ้สียเวลาในการหยบิดงันั้น 
แม่คา้ควรนาํเสน้ก๋วยเต๋ียวและถัว่งอกมารวมไวใ้นท่ีเดียวกนั อีกตวัอยา่งหน่ึง ไดแ้ก่ สมยัก่อนจะกิน
กาแฟ เราตอ้งเสียเวลาตกักาแฟ เสร็จแลว้ตอ้งมาตกันํ้าตาลและครีมเทียม แต่ตอนน้ีมีการผลิตกาแฟ
ในซองแบบ 3 in 1 คือ มีกาแฟ นํ้าตาล ครีมเทียม อยูใ่นซองเดียวกนัซ่ึงเป็นการนาํมารวมกนั 
เพื่อท่ีจะประหยดัเวลา และพกพาไดส้ะดวก 

2.2.3 จัดเรียงใหม่ (Rearrange) 
ถา้หากวา่วิธีการทาํงานแบบเดิมมีความสูญเสียเกิดข้ึน ไม่วา่เกิดจากระยะทางในการหยบิส่ิงของ
ต่างๆ ซ่ึงทาํใหเ้กิดความสูญเสียได ้ถา้ระยะทางกบัส่ิงของนั้นอยูไ่กลกนั เช่น ในร้านอาหาร โตะ๊
ลูกคา้ กบั ท่ีวาง จาน ชอ้น สอ้ม นํ้า และนํ้าแขง็ อยูไ่กลกนัมาก ทาํใหต้อ้งใชเ้วลานานในการไปหยบิ
ส่ิงเหล่าน้ี ดงันั้น ควรมีการจดัเรียงใหม่ เช่น จาน ชอ้น สอ้ม นํ้า และนํ้าแขง็ ซ่ึงเป็นของท่ีใชบ่้อยๆ 
มาวางไวใ้กลโ้ตะ๊ของลูกคา้ เม่ือลูกคา้สัง่จะไดห้ยบิไดท้นัท่วงที และควรมีหลายๆจุด หรือตวัอยา่ง
แม่คา้ขายก๋วยเต๋ียว การลวกลูกช้ินและเน้ือหมู ตอ้งใชเ้วลาในการลวกใหลู้กคา้แต่ละคน คนละ 30 
วินาที ซ่ึงใชเ้วลานาน แม่คา้อาจเปล่ียนวิธีการใหม่โดยอาจจะลวกลูกช้ิน กบัเน้ือสตัว ์เตรียมไวก่้อน
เวลาท่ีนกัเรียนจะพกัรับประทานอาหาร เม่ือนกัเรียนสัง่ก๋วยเต๋ียว แม่คา้กใ็ส่เน้ือหมู ลูกช้ินท่ีสุกแลว้
ลงในชามโดยไม่ตอ้งมาทาํในขณะท่ีนกัเรียนสัง่กจ็ะทาํใหล้ดเวลาไดถึ้งคนละ 30 วินาที หรือ คร้ัง
ละมากๆ เพื่อไม่ใหเ้ป็นการเสียเวลา และลูกคา้กไ็ม่ตอ้งรอนาน 
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2.2.4  การทาํให้ง่ายขึน้ (Simplify) 
ถา้ไปหอ้งสมุดจะเห็นวา่ หอ้งสมุดท่ีดีนั้น นอกจากมีหนงัสือท่ีดีแลว้ยงัตอ้งคน้หาไดง่้ายดว้ย  
และสาเหตุท่ีคน้หาหนงัสือไดง่้ายนั้น เพราะมีการแบ่งแยกประเภทหมวดหมู่ไวอ้ยา่งชดัเจน มีป้าย
ติดแสดงประเภทของหนงัสือแต่ละประเภททาํใหเ้ราสามารถคน้หาหนงัสือไดอ้ยา่งรวดเร็ว ในการ
ทาํงานต่างๆ กแ็ข่งกนัเราตอ้งคิดวา่ทาํอยา่งไรจึงจะทาํให ้ง่ายข้ึน เช่น ร้านขายก๋วยเต๋ียว แม่คา้ตอ้ง
นาํถงัแก๊สออกมาหนา้ร้านทุกวนั พอตอนเยน็กน็าํถงัแก๊สไปเกบ็หลงัร้าน การท่ีตอ้งยกถงัแก๊สทุก
วนันั้น เป็นส่ิงท่ีลาํบากเพราะถงัแก๊สมีนํ้าหนกัมากและถา้ยกไม่ถูกวิธีอาจจะ 
ก่อใหเ้กิดอนัตรายได ้ดงันั้น จึงมีการคิดวา่จะขนถงัแก๊สอยา่งไรใหง่้ายจึงมีการประดิษฐท่ี์รองถงั
แก๊สท่ีมีขนาดวงกลมทาํดว้ยเหลก็และรองขา้งล่างท่ีทาํดว้ยลอ้เพ่ือใหส้ามารถเล่ือนไปไหนมาไหน
ไดอ้ยา่งสะดวก เม่ือจะนาํถงัแก๊สออกไปหนา้ร้านกย็กประหยดัแรงงานอีกดว้ย 
หลกั E-C-R-S น้ีไม่จาํเป็นตอ้งใชท้ั้งหมดพร้อมกนั จะเลือกใช ้E C R S ตวัใดตวัหน่ึงกไ็ดต้ามความ
เหมาะสม 
 

2.3 การวางผงัโรงงาน   

หมายถึง  งานหรือแผนการในการติดตั้งเคร่ืองจกัร เคร่ืองมือ อุปกรณ์  และวตัถุต่าง ๆ  ท่ีจาํเป็นใน
กระบวนการผลิต  ภายใตข้อ้จาํกดัของโครงสร้าง และการออกแบบของอาคารท่ีมีอยู ่ เพื่อทาํใหก้าร
ผลิตมีความปลอดภยั และมีประสิทธิภาพสูงสุด ปัจจยัในการพิจารณาในการวางแผนผงัโรงงาน  มี
ขอ้พิจารณา  ดงัน้ี 

 -  ความตอ้งการของผลิตภณัฑ ์ การวางแผนผงัควรมีความยดืหยุน่เพื่อการเปล่ียนแปลงการใช้
เคร่ืองจกัร  
-  การเส่ียงต่อความลา้สมยัของเคร่ืองจกัร  จากความตอ้งการผูบ้ริโภคท่ีตอ้งการผลิตภณัฑรู์ปแบบ
ใหม่ ๆ 
-  คุณภาพของผลผลิต  การวางแผนผงัไม่ถูกตอ้ง  อาจมีผลใหคุ้ณภาพของสินคา้ลดลง 
-  ค่าใชจ่้ายในการบาํรุงรักษา  ควรคาํนึงถึงการผลิตท่ีต่อเน่ืองกนัเพื่อลดตน้ทุนในการบาํรุงรักษา 

2.3.1 ขั้นตอนในการวางผงัโรงงานมีด้วยกนั 3 ขั้นตอน 

 2.3.1.1  การวางผงัโรงงานขั้นตน้  การวางผงัโรงงานแบบน้ีเป็นการกาํหนดขอบเขตเอาไวก้วา้ง   วา่
จะกาํหนดใหพ้ื้นท่ีน้ีทาํอะไร  พื้นท่ีตรงน้ีตอ้งอยูใ่กลก้บัหน่วยงานใด  เป็นตน้ 
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  2.3.1.2  การวางผงัโรงงานอยา่งละเอียด  กเ็ป็นการกาํหนดราละเอียดในแต่ละแผนกวา่ในแผนกน้ี
จะติดตั้งเคร่ืองจกัร  เคร่ืองมือตรงไหน  มุมไหน  ทางเดินภายในแผนก  จะกาํหนดอยา่งไร  สรุป
แลว้การวางผงัโรงงานอยา่งละเอียด  กคื็อการมองไปในรายละเอียดของแต่ละแผนกนัน่เอง 
 2.3.1.3  การติดตั้งเคร่ืองจกัร  ขั้นน้ีเป็นขั้นนาํการวางผงัโงงานอยา่งละเอียดมาสู่การปฏิบติั  ก็
คือ  การติดตั้งเคร่ืองจกัรตามท่ีวางผงัไวแ้ลว้ใหส้ามารถปฏิบติังานได ้

              ใน การวางผงัโรงงานนั้น  ผูว้างผงัควรมีการวางใหรั้ดกมุมากพอสมควร  จึงจะทาํใหก้าร
วางผงัโรงงานเกิดผลดี  และไดใ้ชป้ระโยชน์จากโรงงานอยา่งคุม้ค่า  เช่น 

-  วางผงัโรงงานขั้นตน้ก่อน  แลว้จึงวางผงัอยา่งละเอียด 
  -  ควรออกแบบผงัโรงงานไวเ้ลือกหลายแบบ 
 -  ผูว้างผงัโรงงานตอ้งรู้วา่  ผูบ้ริหารจะเลือกวิธีการขนยา้ยวสัดุภายนอก ภายในโรงงานแบบใด 
  -  ควรมีการติดต่อขอความคิดเห็นจากบุคคลท่ีเก่ียวขอ้ง 

 
  2.3.2 ระบบการวางผงัโรงงาน 

ระบบการวางผงัโรงงานท่ีดี  จะตอ้งสอดคลอ้งกบัระบบการผลิต  ซ่ึงการวางผงัโรงงานมี
ดว้ยกนั  4  ระบบ  คือ 

       2. 3.2.1  การวางผงัโรงงานแบบตามกระบวนการผลิต 
       2.3.2.2  การวางผงัโรงงานแบบตามชนิดของผลิตภณัฑ ์
       2.3.2.3  การวางผงัโรงงานแบบผสม 
       2.3.2.4  การวางผงัโรงงานแบบช้ินงานอยูก่บัท่ี 

               การ วางผงัโรงงานแต่ละแบบกมี็ขอ้ดีและขอ้จาํกดัแตกต่าง  ทั้งน้ี ผูบ้ริหารจะเลือกระบบ
การวางผงัโรงงานแบบใด  กต็อ้งข้ึนอยูก่บัระบบการผลิตในโรงงานเป็นหลกัในการพิจารณา 
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2.4 ทฤษฎกีารจดัทาํคู่มือการทาํงาน 
    คู่มือการทาํงานหมายถึง เอกสารท่ีแต่ละหน่วยงานสร้างข้ึนมาเพื่อเป็นแนวทางในการปฏิบติังาน
ของหน่วยงานนั้นๆ และยงัใชเ้ป็นคู่มือสาํหรับศึกษาการปฏิบติังานของบุคลากรในหน่วยงาน อีกทั้ง
ยงัสามารถปรับปรุงใหส้อดคลอ้งกบัระเบียบ วิธี และ เทคโนโลยท่ีีเปล่ียนไปในอนาคต 
 
2.4.1 โครงสร้างคู่มือการปฏบิัติงาน 
  ประกอบดว้ย 
2.4.1.1 วตัถุประสงค ์
2.4.1.2 ขอบเขต 
2.4.1.3 คาํจาํกดัความ 
2.4.1.4 โครงสร้างของหน่วยงาน 
2.4.1.5 ความรับผดิชอบ 
2.4.1.6 ขั้นตอนการปฏิบติังาน 
2.4.1.7 เอกสารอา้งอิง 
2.4.1.8 บรรณานุกรม 
 
2.4.2 วตัถุประสงค์ของการจัดทาํคู่มือปฏบิตัิงาน 
2.4.2.1 เพื่อใหก้ารปฏิบติังานเป็นมาตรฐานเดียวกนั 
2.4.2.2 ผูป้ฏิบติังานทราบวา่ควรปฏิบติังานอยา่งไร เม่ือใด กบัใคร 
2.4.2.3 เพื่อใหก้ารปฏิบติังานสอดคลอ้งกบันโยบาย และ วิสยัทศัน ์
2.4.2.4 ผูป้ฏิบติังานทราบและเขา้ใจวา่ควรทาํอะไรก่อนและหลงั 
2.4.2.5 ผูบ้ริหารสามารถติดตามงานไดทุ้กข้ึนตอน 
2.4.2.6 เป็นเคร่ืองมือในการฝึกอบรม 
2.4.2.7 ใชเ้อกสารอา้งอิงในการทาํงาน 
2.4.2.8 บุคลากรสามารถทาํงานแทนกนัได ้
2.4.2.9 ลบขอ้ผดิพลาดจากการทาํงานท่ีไม่เป็นระบบ 
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2.4.3 ลกัษณะของคู่มือการปฏิบัตงิานทีด่ ี
2.4.3.1 ชดัเจน และ เขา้ใจง่าย 
2.4.3.2 เป็นประโยชน์ในการทาํงานและการฝึกอบรม 
2.4.3.3 เหมาะสมกบัหน่วยงานและผูใ้ชง้านแต่ละกลุ่ม 
2.4.3.4 มีความน่าสนใน น่าติดตาม 
2.4.3.5 มีความเป็นปัจจุบนั (Update) ไม่ลา้สมยั 
2.4.3.6 มีตวัอยา่งประกอบ 
 
2.4.4 โครงสร้างและรูปแบบของ คู่มือการปฏิบตัิงาน 
ไม่มีโครงสร้างและรูปแบบท่ีชดัเจนและเป็นมาตรฐาน ซ่ึงสามารถเขียนไดห้ลายลกัษณะตาม
รูปแบบของงาน แต่ ควรจะเขียนใหส้ามารถอ่านแลว้เขา้ใจง่าย ไม่วกไปวนมา  ยดืหยุน่ และรัดกมุ 
ใชค้าํศพัทใ์หเ้หมาะสมกบัผูใ้ชง้าน 
 
2.4.5 ระดับของคู่มือการปฏบิัติงาน  
2.4.5.1  Manual book  เป็นคู่มือการปฏิบติังานท่ีนาํเอา กฎ ระเบียบ ขอ้บงัคบั มติหนงัสือเวียน หรือ 
หนงัสือตอบขอ้หารือท่ีเก่ียวขอ้ง และ นาํมารวบรวมไว ้เป็นหมวดหมู่แลว้จดัทาํเป็นรูปเล่ม 
2.4.5.2 Cook book เป็นคู่มือการปฏิบติังานสูงข้ึนมาอีกหน่ึงระดบั มีลกัษณะเหมือนระดบัท่ี1 แต่ได้
เพิ่มขั้นตอน และ วิธีการปฏิบติังานเขา้ไป  
2.4.5.3 Tip book เป็นคู่มือการปฏิบติังานระดบัสูงสุด ท่ีมีลกัษณะเหมือน ระดบัท่ี1 และ ระดบัท่ี2  
แต่เพิ่มเทคนิควิธีการ หรือ ประสบการณ์ จากผูท่ี้ปฏิบติังานมานานเขา้ไป  
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บทที ่3 
แผนงานการปฏิบัตงิานและขั้นตอนการดาํเนินงาน 

 

3.1 ตารางแผนงานการฝึกงาน 

 

 
 

Actual 
 

ตารางที ่3.1  ตารางแผนการปฏิบติังานการฝึกงาน 
 

3.2 รายละเอยีดงานทีนั่กศึกษาปฏิบัตใินการฝึกงาน 
3.2.1 ลงประชาสมัพนัธ์ข่าวภายในเวป็ไซตI์ntranet องคก์ร 
เม่ือมีข่าวหรือเหตุการณ์บางอยา่งเกิดข้ึนกบัองคก์ร เช่น แจง้เหตุญาติพีน่อ้งผูบ้ริหารเสียชีวิต , การ
แจง้เตือนเร่ืองวนั/เวลารถรับส่งพนกังานในวนัหยดุ เป็นตน้   เม่ือไดรั้บคาํสัง่แลว้กจ็ะทาํการแกไ้ข
หนา้เวป็เพื่ออพัเดทข่าวดงักล่าวลงในเวป็ไซต ์เพื่อแจง้ใหทุ้กฝ่ายทราบโดยทัว่กนั 
3.2.2 งานทาํบตัรพนกังาน  
เม่ือมีพนกังานใหม่เขา้มาปฏิบติังานภายในบริษทั กต็อ้งมีหนา้ท่ีดาํเนินการออกบตัรพนกังานใหก้บั
พนกังานคนดงักล่าว โดยใชเ้ป็นบตัรประเภท Smart Card  โดยมีหนา้ท่ีดาํเนินการตั้งแต่ กรอก
ฐานขอ้มูลพนกังานลงใน Data จนกระทัง่ ไดเ้ป็นบตัร Smart Card ออกมา 
3.2.3 รับหนา้ท่ีเป็นเจา้หนา้ท่ีตรวจสารเสพติด 
จากการปฏิบติังานท่ีผา่นมา ในส่วนของการตรวจสารเสพติดของโครงการ โรงงานสีขาวนั้น จะมี
ข้ึนในช่วงวนัท่ี 5 - 8 พฤษภาคม พ.ศ.2557  ดงันั้นทางหวัหนา้และผูจ้ดัการแผนกจึงมีคาํสัง่ให ้ไปทาํ
หนา้ท่ีตรวจหาสารเสพติดใหก้บัพนกังานท่ีอายไุม่เกิน 45 ปี 

Plan 
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3.3 ขั้นตอนการดาํเนินงานทีนั่กศึกษาปฏิบัตงิาน 

เน่ืองจากการทาํบตัรพนกังานแบบ Smart Card นั้นสามารถปรับปรุงขั้นตอนในการทาํงานได ้ และ
ยงัขาดคู่มือในการทาํบตัรพนกังาน จึงไดท้าํการเลือกหวัขอ้น้ีเป็นโครงงาน โดยมีขั้นตอนในการ
ดาํเนินการ ดงัน้ี 
 
3.3.1ทาํการศึกษาขั้นตอนในการทาํบตัรพนกังานจาก พนกังานท่ีปรึกษา 
3.3.2 ดาํเนินการปฏิบติัเองจะกระทัง่เกิดความเคยชิน 
3.3.3 ลงมือทาํพร้อมทาํการจบัเวลา ทั้งหมด 3 คร้ัง คร้ังละ 1 วนั 
3.3.4 วาด Flow Chart พร้อมพิจารณา หาปัญหาท่ีเกิดข้ึน 
3.3.5 ดาํเนินการแกไ้ข 
3.3.6 นาํเสนอแนวทางการปรับปรุง 
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บทที ่4 
ผลการดาํเนินโครงงาน การวเิคราะห์และสรุปผลต่างๆ 

4.1 ขั้นตอนและผลการดาํเนินโครงงาน  
4.1.1 ศึกษาขั้นตอนและกระบวนการในการทาํบัตร Smart Card 
 

แผนภาพที ่4.1 Flow Chart แผนภาพแสดงการไหลของงานในแผนก Sorting and Packing 
 

ภาพที ่4.1  ภาพกระบวนการทาํงานของการทาํบตัรพนกังาน โดยรวม 
 
 
 
 
 



23 
 

ขั้นที ่1. กระบวนการ รอการออกรหัส 

 
 
 
 
 
 
 

 
                                 ภาพที ่4.2  ภาพกระบวนการทาํงานของการรออนุมติัรหสัพนกังานใหม่ 

 
จากการทาํงานของขั้นตอนน้ี คือการรอทางสาํนกังานใหญ่ (TYL)  ทาํการรับทราบเร่ือง วา่ ทาง
โรงงานบางพลีมีพนกังานใหม่เขา้มา แลว้หลงัจากนั้น เม่ือทางสาํนกังานใหญ่ทราบเร่ือง กจ็ะ
ดาํเนินการ Created  รหสัพนกังานให ้ใหท้าํการ Confirm กลบัมาทาง อีเมล Outlook  ซ่ึงในขั้นตอน
น้ีส่ิงท่ีควรทาํคือ การ Refresh  Outlook บ่อยๆ เพื่อไม่ใหท้ราบเร่ืองล่าชา้ 
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ขั้นตอนที ่2. กระบวนการ กรอกรหัสและช่ือลงใน Data (Eexel) 

 
                                
                                      ภาพที ่4.3  กระบวนการกรอกช่ือ และรหสัลงใน Data Exel  

 
ในกระบวนการน้ีเป็นการ กรอกรายละเอียดของพนกังานใหม่ลงใน Data บตัร เพื่อเป็นฐานขอ้มูล
การมีตวัตนอยูจ่ริงของพนกังานคนดงักล่าว โดยมีลาํดบัขั้นตอน ดงัน้ี  
1.คลิกเขา้ไปท่ี ไดฟ์ D > MasterTech > DataCard     > Data.dbf 
2.Copy ช่ือ , นามสกลุ ทั้งภาษาไทยและองักฤษ , สงักดั , ตาํแหน่ง และ รหสั พนกังานลงในเซล 
ตามภาพ 
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ขั้นตอนที ่3. กระบวนการ กรอกช่ือ นามสกลุ และรหัส ลงใน Note Pad 
 

 
 
 
 
 
 

 
   

 
 
 
 

 
ภาพที ่4.4  กระบวนการกรอกช่ือ และรหสัลงใน Data (Note Pad) 

 
ในกระบวนการน้ี เป็นการกรอกขอ้มูล เพื่อเป็น Data หรือเป็นฐานขอ้มูลในการ Write Card  ในตวั 
Smart Card (ไม่ใช่หนา้บตัร) โดยมีขั้นตอน ดงัน้ี 
1.คลิกไปท่ี ไดฟ์ D > MasterTech > รายช่ือWriteCard >Write_Card.txt 
2.ทาํการกรอก ช่ือ , นามสกลุ เป็นภาษาองักฤษ รวมถึงรหสัพนกังานดว้ย 
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ขั้นตอนที ่4. กระบวนการ โทรแจ้งต้นสังกดั เพือ่ให้พนักงานมาถ่ายภาพ 
 
 
 

 
 
 
 
 
 

ภาพที ่4.5  กระบวนการติดต่อตน้สงักดั โดยโทรศพัทภ์ายใน 
 
 
 
 

ขั้นตอนที ่5. กระบวนการ ถ่ายภาพ 
 

 
 
 
 
 
 

ภาพที ่4.6  กระบวนการถ่ายภาพใหก้บัพนกังานใหม่ 
 
      เม่ือพนกังานเดินมาถึงแผนกแลว้ จากนั้นทาํการนาํพาไปยงัหอ้งถ่ายภาพและทาํการจดัระเบียบ
ในส่วนของความตรงของใบหนา้ องศาการตั้งฉากของใบหนา้ เป็นตน้  เพื่อนาํภาพท่ีถ่ายได ้ไปเป็น 
Data Picture เพื่อใชใ้นการทาํบตัรพนกังาน ต่อไป 
 
 

จากนั้นกท็าํการ โทรผา่นหมายเลขภายในองคก์ร ไปยงัตน้สงักดัท่ีพนกังานคนดงักล่าว ปฏิบติังานอยู ่
เพื่อ ขออนุญาตหวัหนา้งานของเขา จากนั้น รอจนกวา่จะเดินมาถึง 
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ขั้นตอนที ่6. Copy File จาก Card Reader ลงบนคอมพวิเตอร์ 
 
 
 
 
 
 
 
 
 
 

ภาพที ่4.7  การก๊อปป้ีไฟลล์งบน Data 
 
การทาํงานในขั้นตอนน้ี คือ เม่ือเราไดภ้าพของพนกังานใหม่เป็นท่ีเรียบร้อยแลว้ ไฟลจ์ะอยูใ่น 
Memory Card ของกลอ้ง ดิจิตอลท่ีเราทาํการถ่ายภาพและตอ้งดาํเนินการ ดงัน้ี 

- นาํอุปกรณ์ท่ีเรียกวา่ Card Reader ออกมา แลว้ถอด Memory จากกลอ้งถ่ายภาพมาเสียบกบั 
Card Reader  

- เสียบเขา้กบั USB Computer  จะไดโ้ฟเดอร์ตามภาพซา้ยมือ  
- ทาํการคน้หาภาพท่ีเราตอ้งการ แลว้ทาํการกลบัดา้นใหเ้รียบร้อย แลว้จึง Copy ภาพนั้นไป

วางไวท่ี้  D > MasterTech > Data_Card 
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ขั้นตอนที ่7. แต่งภาพโดย Photoshop 
 
 
 
 
 

 
 

 
 

 
 

ขั้นตอนที ่8. เปิดไฟล์ภาพขึน้มา 
 
  

 
 

 
 
 
 

 
 ภาพที ่4.9 การเลือกรูปภาพเพื่อทาํการปรับแต่ง 
 

 
 
 
 
 
 

เปิดไฟลด์งักล่าวโดยการคลิกท่ี 
File>Open จากนั้นกเ็ลือกไปท่ีท่ีเรา
เลือกเกบ็ไฟลภ์าพไว ้ซ่ึงนัน่กคื็อ โฟ
เดอร์ Data_Card 

ภาพที ่4.8  การเลือกใชโ้ปรแกรม Photoshop 



29 
 

ขั้นตอนที ่9. หาภาพใกล้เคยีงเพือ่ตดัต่อ 
 
 

 
 
 
 
 
 
 

 
ภาพที ่4.10  การปรับแต่งภาพ 

 
คลิกเขา้ไปท่ีโฟเดอร์ Data_Card จะพบไฟลรู์ปภาพจาํนวนมาก ใหท้าํการเลือกภาพท่ีเป็นเพศและสี
ผวิเดียวกนักบัภาพท่ีตอ้งการจะตดัต่อภาพ เน่ืองจากพนกังานใหม่ยงัไม่ไดรั้บการบรรจุ จึงตอ้งใส่
ชุดสุภาพทัว่ไปมาปฏิบติังาน แต่ในหนา้บตัรถูกบงัคบัมาวา่ตอ้งเป็นชุดพนกังาน Thai Arrow สีขาว-
ครีม จึงจาํเป็นท่ีจะตอ้งทาํการตดัต่อ  

 
 
 
 
 
 

 
 
 
 

 
 
 



30 
 

ขั้นตอนที ่10. ตัดต่อชุดให้กบัพนักงาน 
 

 
 
 
 
 
 
 
 
 

   ภาพที ่4.11  การตดัต่อชุดพนกังาน 
 

ขั้นตอนที ่11. การปรับแสงสว่าง 
 
 
 

 
 
 
 
 
 

ภาพที ่4.12  การปรับแสงใหเ้หมาะสม 
 
ในขั้นตอนน้ี เร่ิมจาก การคลิกท่ี Layer > New Adjustment Leyer > Brightness / Contract จากนั้นก็
จะปรากฏแถบในการปรับแสงใหส้มดุลกนั  จากนั้นกท็าํการพิจารณาปรับแสงใหพ้อดี 
 
 
 

เม่ือเลือกเพศและสีผวิท่ีมีความใกลเ้คียงกนั
ไดเ้รียบร้อยแลว้ จากนั้นกท็าํการลากรูป
พนกังานใหม่มาทบักบัรูปพนกังานเก่า 
ต่อจากนั้นกใ็ชเ้คร่ืองมือ Eleser  เพื่อทาํการ
ขจดัส่ิงท่ีเป็นส่วนเกินออกไป เช่น ไรผม เป็น
ตน้ จากนั้นกท็าํการใชเ้คร่ืองมือ สีสเปย ์ แลว้
เลือกสีฟ้า หรือนํ้าเงิน แลว้จึงทาํการพน่ใส่สี
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ขั้นตอนที ่12. การปรับกรอบและ Frame ของภาพ 
 

 
 
 
 
 
 
 
 

 
ภาพที ่4.13  การปรับขนาดรูปใหเ้หมาะสม 

 
เลือกท่ีคาํสัง่ Image > Image Size จากนั้นกจ็าํปรากฏหนา้ต่างท่ีใชใ้นการ กาํหนดขอบรูปในดา้น
ต่างๆ ใหท้าํการเปล่ียนค่าของหวัขอ้ Resolution และ Width ใหเ้ป็น 180 ทั้งสองหวัขอ้ เน่ืองจาก ค่า 
180 จาํทาํใหเ้ม่ือปร๊ินภาพออกมาแลว้ รูปภาพของพนกังานจะพอดีกบักรอบท่ีกาํหนดพอดี 
 
 

ขั้นตอนที ่13. เซฟเป็นไฟล์ .JPEG 
  

 
 
 
 
 
 
  

 
ภาพที ่4.14  การเซฟและเปล่ียนนามสกลุไฟล ์
 

ทาํการเซฟไฟลภ์าพโดยมีวิธีการ ดงัน้ี คลิกท่ีตวัเลือก File 
> Save  as   จากนั้นตรวจสอบวา่รหสัพนกังานกบัช่ือไฟล์
ภาพตรงกนัหรือไม่ หากตรงกนั ใหท้าํการคลิกท่ี Open as 
เพื่อเลือกนามสกลุไฟล ์ จากนั้นใหเ้ลือกเป็น JPEG แลว้
บนัทึก 
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ขั้นตอนที ่15. เปิดโปรแกรม CardPrint2000 
 

 
 
 
 
 
 

 
 
 
 
 

ภาพที ่4.16  การเลือกใชโ้ปรแกรม เพื่อปร๊ินหนา้บตัร 
 
 
 
 
 

ใหเ้ลือกตาํแหน่งเซฟไปท่ี D > MasterTech > 
Data_Card 
เน่ืองจากโปรแกรม Write บตัรนั้นเม่ือเราจะเลือกรูป
พนกังานท่ีจะปร๊ิน  โปรแกรมจะแสดงรูปจากโฟเดอร์
น้ี หากรูปภาพเป้าหมายไม่ไดอ้ยูใ่นโฟเดอร์ดงักล่าว  
โปรแกรมจะไม่แสดงออกมาและจะทาํใหไ้ม่สามารถ
ปร๊ินรูปออกมาได ้

ดบัเบ้ิลคลิกโปรแกรม CardPrint2000 
ข้ึนมา เพื่อเตรียมการปร๊ินหนา้บตัร
ใหก้บัพนกังาน 

ภาพที ่4.15  การเลือกโฟเดอร์เป้าหมายท่ีจะบนัทึก  

ขั้นตอนที ่14. การเลอืกตําแหน่งทีจ่ะบันทกึ 
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ขั้นตอนที ่16. แสดงตัวอย่างหน้าบัตร 
 
 
 
 
 
 
 
 

 
ภาพที ่4.17  การแสดงตวัอยา่งหนา้บตัร 

 
เม่ือเปิดโปรแกรมข้ึนมาเรียบร้อยแลว้  ใหค้ลิกท่ีคาํสัง่ File > Open แลว้เลือก Prepic จากนั้น
โปรแกรมกจ็ะทาํการแสดงหนา้บตัรออกมา เช่นตวัอยา่งทางภาพขวามือ  รูปท่ีปรากฏในภาพคือ
ภาพจาํลองพนกังานตวัอยา่งเท่านั้น  
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ขั้นตอนที ่17. เตรียมการปร๊ินรูป 
 

 
 
 
 
 
 

 
 
 
 
 
 
 

ภาพที ่4.18  การยนืยนัการสัง่พิมพ ์
 

ในขั้นตอนน้ีมีวิธีในการดาํเนินการคือ  คลิกท่ีปุ่ม File > Print จากนั้นจะได้ตามภาพมุมซ้ายบน   
จากนั้นใหค้ลิกท่ีปุ่ม Print Selection กจ็ะเป็นรายช่ือออกมาโดยอ่านค่าจากโปรแกรม Note Pad ท่ีเรา
ทาํการบนัทึกไว ้ซ่ึงจะปรากฏตามภาพขวาบน จากนั้นขั้นตอนต่อไปคือการ  ไล่หารายช่ือ หรือรหสั
ของพนกังานใหม่ท่ีเราจะทาํการปร๊ินออกมา   
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ขั้นตอนที ่18. ใส่กระดาษปร๊ินรูป 
 

 
 
 
 
 
 
 

 
ภาพที ่4.19  ภาพแสดงขั้นตอนต่างๆในการปร๊ินรูป 
 

 
ขั้นตอนที ่19. กดปุ่มส่ังพมิพ์ 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

ทาํการป้อนกระดาษ A4 แบบกระดาษมนั ลง
บนถาดของเคร่ืองพิมพ ์ เพื่อรอการสัง่พิมพ ์
 

ในขั้นตอนน้ีจะเป็นการ ออกคาํสัง่ยนืยนัใน
การสัง่พิมพรู์ป 
โดยคลิกท่ีปุ่ม Yes ต่อมากท็าํการเดินไปรอ
กระดาษท่ีหนา้เคร่ืองพิมพ ์แลว้นาํออกมา
ดาํเนินการต่อในขั้นตอนต่อไป 

ภาพที ่4.20  การออกคาํสัง่ยนืยนัการสัง่พิมพ ์
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ขั้นตอนที ่20. นํารูปมาตัดและเคลอืบ 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 

         ในการทาํงานในกระบวนการน้ี ค่อนขา้งจะซบัซอ้น โดยเร่ิมจากการนาํรูปท่ีเพิง่พิมพเ์สร็จ มา
ทาํการตดัใหพ้อดีกรอบของรูป เม่ือตดัออกมาไดพ้อดีกรอบแลว้ จะสามารถใส่รูปท่ีตดัมาลงไปใน
ซองเคลือบได ้  จากนั้นคือการรอคอยใหเ้คร่ืองเคลือบมีอุณหภูมิคงท่ี (100องศา) จึงสามารถนาํบตัร
สอดเขา้ไปในเคร่ืองเคลือบได ้โดยทาํการเคลือบทั้งหมด 2 คร้ัง เม่ือเคลือบสาํเร็จแลว้จะไดต้ามภาพ 
มุมขวาล่าง  ซ่ึงจะสงัเกตเห็นไดว้า่ จะมีส่วนเกินในช่วงขอบ ท่ีกวา้งเกินไป ดงันั้นจึงตอ้งทาํการตดั
ออก 

 
 

ภาพที ่4.21  การตดัและเคลือบรูป 
 



37 
 

ขั้นตอนที ่21. นํารูปไปตัดทีเ่คร่ืองตดักรอบบัตร 
 

 
 
 
 
 
 
 

 
 
          กระบวนการน้ีเร่ิมจากการสอดบตัรท่ีเราตดัมา เขา้ไปทางดา้นบนของอุปกรณ์ตดั   เม่ือสอด
เขา้ไปแลว้  บตัรกจ็ะไหลมาตรงกลาง ซ่ึงตรงกลางนั้นจะมีช่องอยู ่ช่องดงักล่าวนั้นคือช่องมาตรฐาน
ระหวา่งขนาดบตัรและขนาดของ Smart  Card    จากนั้นกท็าํการโยกคนัโยกลงเพ่ือเป็นการตดั
กรอบบตัร เม่ือตดัเสร็จแลว้ บตัรท่ีถูกตดักจ็ะไหลลงมาทางช่องขา้งล่าง พร้อมกบัเศษบตัรท่ีถูกตดั
พร้อมกนั 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

ภาพที ่4.22  การตดักรอบบตัร 
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ขั้นตอนที ่22. Write Card 
 
 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 

        
            ในกระบวนการน้ีเร่ิมจากการนาํบตัรเปล่าไปวางไวท่ี้เคร่ือง Write Card  จากนั้นเปิด
โปรแกรม Write Card ขั้นมา ซ่ึงมีช่ือวา่ CIW_TA   เม่ือเปิดข้ึนมาแลว้จะเห็นหนา้ตาของโปรแกรม
ดงัภาพ ขวาบน จากนั้นสงัเกตท่ีแถบเมนูขา้งบนโปรแกรม จะเห็นตวัเลือกท่ีช่ือวา่  Main Menu ให้
คลิกเขา้ไปแลว้เลือกท่ีคาํสัง่ Open  จะไดเ้ป็นไฟล ์Note Pad ออกมา แลว้จึงทาํการคน้หา ช่ือและ
รหสัพนกังานคน้ท่ีตอ้งการจะทาํการ Write Card   เม่ือพบแลว้ใหท้าํการ คลุมดาํท่ีช่ือดงักล่าว 
ต่อจากนั้น คลิกท่ีปุ่ม Write Card   เป็นอนัไดบ้ตัรเปล่าท่ีมีขอ้มูลอยูใ่น Card เรียบร้อย  ( โปรแกรม
จะดึงรายช่ือจากขั้นตอนท่ี 3 ) 
 

ภาพที ่4.23  Write Card 
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ขั้นตอนที ่23. ติดรูปทีห่น้าบตัร 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที ่4.24  การประกอบบตัร 
 

เม่ือทาํการ Write Card เสร็จเรียบร้อยแลว้ เรากจ็ะไดก้าร์ดเปล่าท่ีไม่มีหนา้บตัรแต่ในการ์ดมีขอ้มูล
ของพนกังานคนดงักล่าวอยู ่ จากนั้นนาํการ์ดนั้นออกจากเคร่ือง ซ่ึงลกัษณะของเคร่ืองนั้น จะ
เหมือนกบัภาพ ขวาบน   ลอกสต๊ิกเกอร์ท่ีบตัรเปล่าออก  จากนั้นนาํบตัรท่ีเราตดัมา แปะทบัลงไปซ่ึง
ขนาดจะเท่ากนัพอดี  ต่อจากนั้นนาํตะขอหอ้ยเส้ือมาคลอ้งกบัตวับตัร จะไดเ้ป็นบตัรพนกังาน
ออกมา ดงัภาพซา้ยล่าง 
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4.1.2 ลงมือปฏิบัติด้วยตนเองพร้อมทาํการจับเวลา 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
จาก Flow Process Chart ขา้งตน้แสดงถึง เวลาและระยะทางในการทาํงานปกติของพนกังานประจาํ
หนา้ท่ี ก่อนหนา้ท่ีจะทาํการปรับปรุงงาน และหลงัจากนั้นไดท้าํการปฏิบติัหนา้ท่ีเอง พร้อมดว้ยทาํ
การจบัเวลา ซ่ึงมีขอ้มูลการบนัทึกเวลาอยูใ่นรูปภาพท่ี 4.2 
 
 
 
 
 
 
 
 
 
 
 

ตารางที ่4.1 ตารางแสดงขั้นตอนการทาํงาน 
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จากการลงมือปฏิบติัดว้ยตนเองพร้อมทั้งจบัเวลาไปดว้ยทั้งหมด 3 วนั วนัละ 1 คร้ังสามารถบนัทึก
ผลในเร่ืองของเวลาไดด้งัน้ี 
 
 

 
 

ในส่วนน้ีใชเ้วลาดาํเนินการเพื่อทาํการทดสอบและจบัเวลาเป็นเวลาทั้งส้ิน 3 วนั วนัละ 1 คร้ัง 
จากนั้นนาํเวลาท่ีไดม้า มาทาํการรวบรวม พร้อมทั้งหาค่าเฉล่ียออกมา เพื่อนาํไปวเิคราะห์ปัญหา
ความล่าชา้ของการทาํงาน และจะทาํใหท้ราบวา่ ควรจะแกไ้ขในจุดงานใด และ มีขั้นตอนในการ
ดาํเนินการอยา่งไร   โดยใหส่้งผลกระทบต่อขั้นตอนของกระบวนการทาํงานนอ้ยท่ีสุด 
 
 
 
 
 
 

ตารางที ่4.2  แสดงการจบัเวลา 



42 
 

4.1.3 ระบุถึงปัญหาของข้ันตอนทีจ่ะทาํการปรับปรุง 
1. พิจารณาจากขั้นตอนท่ี 1 และ ขั้นตอนท่ี 18 ในระหวา่งท่ีรอรหสัพนกังานจากสาํนกังานใหญ่นั้น 
ควรท่ีจะทาํการป้อนกระดาษปร๊ินรูปใหเ้รียบร้อย เพื่อเป็นการลดเวลาในการทาํงาน 
2.ขั้นตอนในการปรับแสงสวา่ง เดิมทีหอ้งท่ีใชใ้นการถ่ายภาพพนกังานนั้นมีแสงสวา่งไม่เพียงพอจึง
ทาํใหภ้าพออกมาดูคลํ้ากวา่ปกติ ดงันั้นจึงทาํการยา้ยหอ้งถ่ายรูปใหม่ โดยใหมี้แสงสวา่งเป็นหลกั จึง
ทาํใหไ้ม่ตอ้งทาํการแต่งภาพ ดงันั้นจึงสามารถตดัขั้นตอนท่ี 11  ออกไปได ้
3.ขั้นตอนท่ี  21 คือ การนาํรูปท่ีเคลือบแลว้ไปตดัใหอ้อกมาพอดีกบักรอบบตัร  เดิมทีแลว้เคร่ืองตดั
กรอบบตัรนั้นจะตั้งอยูท่ี่ ชั้น 3 ของอาคาร ดงันั้นจึงทาํเร่ืองขออนุมติัหวัหนา้แผนกบุคคลใหย้า้ย
เคร่ืองดงักล่าวมาตั้งไวใ้กล้ๆ  แผนก เพยีง 8 เมตร (จากเดิม 160เมตร)  ทาํใหล้ดระยะทาง และ เวลา
ในการทาํงานลงไดม้าก 
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4.1.4 สรุปถึงปัญหาของงานทีจ่ะต้องแก้ไข 
 
ตารางที ่4.3  บอกถึงขั้นตอนท่ีควรแกไ้ข 
 

 
 
 
 
 
 
 
 
 
 
 
 

- ทาํการแกไ้ขโดยตดัขั้นตอนในการปรับแสงสวา่งออกไป เน่ืองจากทีหอ้งถ่ายภาพท่ีมีแสง
สวา่งมากเพียงพอแลว้ 

- ทาํการแกไ้ขโดยยา้ยเคร่ืองตดักรอบบตัรจากชั้น 3 ของอาคาร มาไวท่ี้ตูว้างของของแผนก
บุคคล 

- ทาํการแกไ้ขมาตรฐานการทาํงานโดยสร้างคู่มือในการทาํงานเร่ือง การออกบตัรพนกังาน
ชัว่คราว 

- ทาํการแกไ้ขมาตรฐานการทาํงานโดยสร้างคู่มือในการทาํงานเร่ือง การแกไ้ขฐานขอ้มูลของ
พนกังาน 

- ทาํการแกไ้ขมาตรฐานการทาํงานโดยสร้างคู่มือในการทาํงานเร่ือง การออกบตัรพนกังาน
ทัว่ไป 
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4.1.5 ดําเนินการแก้ไข 
 
ดาํเนินการแกไ้ขขั้นท่ี 1  ทาํการยา้ยหอ้งถ่ายภาพพนกังาน เพื่อท่ีจะไดไ้ม่ตอ้งปรับแสงสวา่ง 
 

 
 
 
 

 
  

 
ภาพที ่4.25  การลดขั้นตอนโดยการยา้ยหอ้งถ่ายรูป 

 
จากเดิมจะใชห้อ้งในการถ่ายภาพท่ีไม่มีหลอดไฟท่ีมีความสวา่งมากนกั ดงัเช่นรูปซา้ยมือ จากนั้นได้
ทาํการขออนุมติัในการขอเขา้หอ้งกิจกรรม2 ซ่ึงมีแสงท่ีสวา่งท่ีมากพอสมควร รวมถึงสามารถเปิด
ไฟ Sport Light  เพื่อเพิ่มความสวา่งไดอี้กดว้ย จึงทาํใหล้ดขั้นตอนในการปรับแสงสวา่งภาพลงได ้
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ดาํเนินการแกไ้ขขั้นท่ี 2 ยา้ยเคร่ืองตดักรอบบตัรมาไวท่ี้บริเวณใกลเ้คียง 
  

 
 

 

ภาพที ่4.26  การยา้ยเคร่ืองเคลือบบตัร (Before) 
 
จากแผนผงัแสดงใหเ้ห็นวา่   ระยะทางจากแผนกบุคคลซ่ึงอยูช่ั้น 2 ของอาคาร ไปสู่เคร่ืองตดักรอบ
บตัรนั้นมีระยะทางท่ีไกลพอสมควร จึงส่งผลใหเ้สียเวลาในการทาํงานในขั้นตอนน้ีมากพอสมควร 
และเน่ืองจากเคร่ืองตดักรอบบตัรมีขนาดเลก็และสามารถเคล่ือนยา้ยได ้จึงทาํการหารือกบัพนกังาน
ท่ีปรึกษาเพื่อท่ีจะเคล่ือนยา้ยไปในตาํแหน่งท่ีใกลก้บัการทาํงาน 
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                                          ภาพที ่4.27  การยา้ยเคร่ืองตดักรอบบตัร (After) 
 
         ภาพดงักล่าวแสดงใหเ้ห็นถึง ระยะทางท่ีใชใ้นการเดินทางท่ีลดลงอยา่งมาก เม่ือเปรียบเทียบ
กบัภาพท่ี4.30  
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ภาพที ่4.28  กราฟแสดงระยะทางท่ีลดลง 

 
หลงัจากท่ีไดน้าํเสนอการเคล่ือนยา้ยเคร่ืองตดักรอบบตัร ทาํใหร้ะยะทางท่ีใชใ้นการเคล่ือนท่ีลดลง 
และ สามารถลดเวลาท่ีใชใ้นการทาํบตัรพนกังานไดอี้กดว้ย 

 

ตารางที ่4.4  ตารางแสดงขั้นตอนท่ีควรปรับปรุง 
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ภาพที ่4.29  กราฟแสดงเวลาท่ีลดลงจากเดิม 

 
หลงัจากท่ีได้ทาํการนําเสนอแนวคิดในเร่ืองของการขอยา้ยห้องถ่ายภาพ และ การขอยา้ยเคร่ือง
เคลือบบัตรมาไวใ้นตาํแหน่งใกล้เคียงกับการปฏิบัติงาน  เพื่อท่ีจะได้ลดเวลาโดยรวมลง และ 
สามารถลดระยะทางในการเคล่ือนท่ีลงได ้  การนาํเสนอแนวคิดดงักล่าวไปกเ็น่ืองมาจาก เม่ือทาํการ
ปฏิบติังาน และ เม่ือถึงกระบวนการตดักรอบบตัร พบวา่ระยะทางของเคร่ืองจกัรนั้นมีความไกลมาก
เกินไป ซ่ึงคิดว่าจะเป็นการเสียเวลาในการเดินทางไปปฏิบติังานโดยเปล่าประโยชน์  จึงทาํเร่ืองของ
อนุมติัโดยตอ้งเร่ิมปรึกษาพนักงานท่ีปรึกษาก่อน ต่อจากนั้นพนกังานท่ีปรึกษาก็ไดแ้จง้เร่ืองไปยงั
หัวหน้างาน และ สุดทา้ยเร่ืองก็ไปสู้ผูจ้ดัการแผนก แลว้ก็ได้รับการอนุมติัในท่ี ทั้งน้ีเม่ือทาํการ
อนุมัติเรียบร้อยแล้ว ได้ทําการงานผูจ้ ัดการแผนกในเร่ืองของเวลาในการทํางานท่ีลดลงของ
กระบวนการตดักรอบบตัร และ เพิ่มเติมในส่วนของการขอยา้ยห้องถ่ายภาพทาํให้สามารถตดั
ขั้นตอนในการปรับแสงภาพใหส้วา่งท้ิงไปได ้อีกดว้ย 
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บทที ่5  
บทสรุปและข้อเสนอแนะ 

 
5.1 สรุปผลการดาํเนินงาน 
 จากการท่ีไดรั้บมอบหมายปฏิบติังานท่ีแผนกบุคคล ฝ่ายสารสนเทศและประชาสัมพนัธ์ ซ่ึง
หน้าท่ีหลักๆคือการทําบัตรพนักงาน โดยพบความล่าช้าในบางกระบวนการของการทําบัตร
พนกังาน  ดงันั้นจึงไดท้าํการศึกษาโดยทฤษฎีท่ีใชใ้นการแกไ้ขปัญหาดงักล่าวคือ ใช ้Flow Process 
Chart ในการวิเคราะห์กระบวนการทาํงานทั้งหมดเพื่อตรวจสอบความสูญเปล่าจากนั้นใชห้ลกัการ 
ECRS และพื้นฐานการวางผงัการทาํงานในการหาแนวทางปรับปรุง จากผลการศึกษาทาํใหส้ามารถ
ปรับปรุงการทาํงานไดโ้ดยยา้ยเคร่ืองตดักรอบบตัรใหใ้กลข้ึ้น ทาํใหล้ดระยะทางและเวลาลงได ้และ
ปรับปรุงขั้นตอนในการยา้ยห้องถ่ายภาพให้มีแสงสว่างเพ่ิมมากข้ึนจึงไม่ต้องไปปรับแสงใน
คอมพิวเตอร์ ซ่ึงทาํให้เป็นไปตามวตัถุประสงค์ท่ีกาํหนดไว ้โดยกาํหนดให้ลดเวลาท่ีใช้ในการ
ทาํงานลงอยา่งนอ้ย 30 % ซ่ึงสามารถลดเวลาลงได ้36%  และ กาํหนดใหก้ารลดระยะทางตอ้งลดลง
อยา่งนอ้ย 60% ซ่ึงผลออกมาสามารถลดระยะทางลงไดถึ้ง 70% ส่งผลใหบ้รรลุเป้าหมายทั้ง 2 หวัขอ้ 
และไดจ้ดัทาํคู่มือการทาํงานในการทาํบตัรพนักงานให้เป็นมาตรฐาน เพ่ือใชเ้ป็นแนวทางในการ
ทาํงานกบัผูรั้บผดิชอบได ้
 

5.2 แนวทางในการแก้ไขปัญหา 
 ควรมีการติดคู่มือในการใช้อุปกรณ์ต่างๆในการทาํบัตรพนักงาน  เน่ืองจากมีอุปกรณ์
มากมายท่ีเก่ียวขอ้งกบัการทาํบตัรพนกังานแลว้ยงัก่อให้เกิดอนัตรายต่อตวัผูใ้ชอี้กดว้ย เช่น ทาํการ
ติดขั้นตอนการใชเ้คร่ืองเคลือบบตัร ซ่ึงหากผูป้ฏิบติังานไม่คุน้เคยกบัเคร่ืองดงักล่าว อาจทาํให้ถูก
ความร้อนจากเคร่ืองไดห้ากสัมผสัในจุดท่ีมีความร้อนสูง หรือ ทาํการติดคู่มือการใชง้านท่ีเคร่ืองตดั
กรอบบตัร เน่ืองจากอุปกรณ์ดงักล่าวทาํข้ึนมาจากของมีคม หากตอนตดักรอบบตัรแลว้ผูป้ฏิบติังาน
เกิดเผลอเลอน้ิวเขา้ไปอยูน่อกกรอบ อาจทาํให้เกิดอุบติัเหตุร้ายแรงได ้ หรือไม่ก็ทาํการติดตั้งกลอ้ง
วงจรปิด ไวใ้นพื้นท่ีปฏิบติังาน เพื่อท่ีจะให้ผูจ้ดัการแผนกหรือหัวหนา้งาน สอดส่องดูแลไดท้ัว่ถึง 
หากพนกังานปฏิบติังานไม่ถูกวิธีเพื่อความปลอดภยัของผูป้ฏิบติั 
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5.3 ข้อเสนอแนะจากการฝึกงาน 
 ในส่วนของการทาํบตัรพนกังานแต่ละรูปแบบนั้นมีขอ้เสนอแนะว่า ตอ้งการใหท้าํการแยก
โฟลเดอร์ให้ชัดเจนกว่าน้ีเพื่อความสะดวกและไม่สับสนในการจดัเก็บภาพและฐานขอ้มูลอ่ืนๆ 
ตลอดจนโฟเดอร์ฐานขอ้มูลท่ีใชใ้นการทาํเวป็ไซต์ประชาสัมพนัธ์ดว้ย อีกทั้งยงัเป็นการป้องกนั
ไม่ใหข้อ้มูลเดิมท่ีใชอ้ยูสู่ญหายอีกดว้ย 
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